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1.1 ABOUT 

ArCADia-EXTERNAL GAS INSTALLATIONS is a tool which allows the ArCADia-INTELLICAD/AutoCAD or 

ArCADia-START user to complete a gas connection with an outdoor gas installation project for one or 

more objects powered by a common outdoor installation. The software is meant both for gas 

network and installation designers, as well as all the people working in the sanitary branch and 

installations branch in the construction industry. When using the ArCADia-EXTERNAL GAS 

INSTALLATIONS software, the user has the possibility to create drawings of the gas connection and 

outdoor gas installation (localized outside the building or the group of buildings) elements. The 

designing process is realised through geodetic backgrounds projections in the form of vector or 

raster images (imported into a DWG file and calibrated). The software allows the user to create 

situational figures of area development with outdoor gas installation objects as well as 

computational schemes and longitudinal profiles of the pipeline course and installation objects. The 

user may also employ a library of objects used when designing, along with an option to edit the 

objects and add technical parameters to them. 

Apart from the option to efficiently create drawings of the installations, the software also carries out 

the calculations necessary for designing the installation correctly (validity checks for the assumed 

diameters, verifying the scope of pressure drop upstream from a gas-powered building) and creating 

a professional technical report. Combining the special functions used to create gas installation plans 

in the scope of pipeline selection and pipeline courses with performing calculations and validating 

the designed installation, the application is a tool for creating outdoor gas installations projects 

which are the base to obtain all the permits required by the building law as well as to validate the 

designed layout. 

1.2 FEATURES AND FUNCTIONALITIES OF THE PROGRAM 

The technical scope of functionalities provided by the software and its basic functions: 

 Creating outdoor gas installation drawings in the scope of routing pipelines, shut-off 

fittings and localization, free-standing and wall-mounted gas cabinet sizes. 

 Creating profiles and calculation diagrams. 

 Determining gas flow in the sections of the gas installation.  

 Calculating pressure losses in the sections of the gas installation. 

 Running validity checks on a designed gas installation. 

 Generating calculation reports. 

 Automatically generating a list of keys to the elements used in the project. 

 Generating lists of materials used in the project. 

The ArCADia-EXTERNAL GAS INSTALLATIONS software takes into consideration the following 

regulations, standards as well as scientific and technical publications: 

Legal acts: 

Regulation of the Minister of Infrastructure of 12 April 2002 on the technical conditions to be met 

by buildings and their locations (Polish Journal of Laws no. 75 item 690) as amended, Polish 

Journal of Laws of 2003 no. 33 item 270 of 13 February 2003 Polish Journal of Laws of 2004 no. 

109 item 1156 of 07 April 2004 Polish Journal of Laws of 2008 no. 201 item 1238 of 06 November 
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2008 Polish Journal of Laws of 2008 no. 228 item 1514 of 17 December 2008 Polish Journal of 

Laws of 2009 no. 56 item 461 of 12 March 2009 Polish Journal of Laws of 2010 no. 239 item 1597 

of 10 December 2010  

Ordinance of the Minister of Infrastructure of 30 July 2001 on the technical conditions to be met 

by gas networks 

Standards: 

PN-C-04750: 2002 – Gaseous fuels. Classification, marking and requirements. 

PN-C-04753:2002 – natural gas. Quality of gas supplied to consumers from the local distribution 

system. 

PN-76/M-34034 – Pipelines. Pressure loss calculation principles. 

PN-74/H74200 : 1998 - Steel pipes with seam, threaded 

PN-EN 10208-1:2009 Steel pipes for pipelines for combustible fluids - Technical delivery 

conditions - Part 1: Pipes Of Requirement Class A 

PN-EN 10208-2:2009 Steel pipes for pipelines for combustible fluids - Technical delivery 

conditions - Part 2: Pipes Of Requirement Class B 

PN-EN 10210-2:2007 - Hot finished structural hollow sections of non-alloy and fine grain steels - 

Part 2: tolerances, dimensions and sectional properties. 

References: 

Bąkowski Konrad: Sieci i instalacje gazowe. Poradnik projektowania budowy i Wyd. III zmienione. 

WNT, Warsaw, 2002. 

Ryszard Zajda, Zdzisław Gebhard. Instalacje gazowe oraz lokalne sieci gazów płynnych. 

Projektowanie, wykonywanie, eksploatacja. Warsaw, 1995 

https://sklep.pkn.pl/?a=show&m=product&pid=561284&page=1
https://sklep.pkn.pl/?a=show&m=product&pid=561284&page=1
https://sklep.pkn.pl/?a=show&m=product&pid=561284&page=1
https://sklep.pkn.pl/?a=show&m=product&pid=550694&page=1
https://sklep.pkn.pl/?a=show&m=product&pid=550694&page=1
https://sklep.pkn.pl/?a=show&m=product&pid=550694&page=1
https://sklep.pkn.pl/?a=show&m=product&pid=550694&page=1
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2. INSTALLING AND RUNNING THE 

PROGRAM 
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2.1 HARDWARE REQUIREMENTS 

 Pentium IV PC (PIV D recommended) 

 2 GB RAM (4 GB recommended) 

 Approximately 1GB of free HDD space for the installation 

 DirectX 9.0 compatible graphics card 

 Windows Vista 32/64-bit OS, Windows 7 32/64-bit or Windows 8 32/64-bit 

 DVD-ROM drive 

2.2 INSTALLING 

The program installation is started automatically when the CD is inserted into the CD drive. The 

installation should be started manually if the Autostart function is disabled. Open the CD content 

(Computer/CD drive), and run the Setup.exe file from the program folder. Once the installation is 

started, proceed according to instructions displayed on the screen. 

2.3 RUNNING 

The ArCADia software: 

The software may be started by double-clicking on the ArCADia-START program icon located 

on the Desktop and then selecting one of the icons on the ribbon in the gas tab 

AutoCAD or ArCADia-INTELLICAD software:  

You can run the program by double-clicking the CAD program icon located on the Desktop 

and then selecting one of the icons on the ArCADia-EXTERNAL GAS INSTALLATIONS toolbar. 

2.4 OPENING A PROJECT (CAD) 

Any of the following file types may be opened: 
A standard DWG drawing file. 

Any of the following sample drawings supplied with the ArCADia-INTELLICAD software may be 

used. 

A DXF drawing exchange file. 

A DWF network transmission file. 

A DWT drawing template file. 

In order to quickly access the last edited drawing choose File> <file name>. The software stores the 

names of the last four drawings. In order to quickly access a drawing from the Open drawing dialogue 

box, double-click the drawing name. 

A drawing may be opened when browsing drawings on the computer using e.g. Windows Explorer. 

All you need to do to open the drawing in IntelliCAD is to double-click the file. Miniature drawings 

displayed when browsing facilitate the identification of the selected drawing. 

 



ArCADia-EXTERNAL GAS INSTALLATIONS User Manual 

Installing and running the program 

 

9 

 

Opening an existing drawing 

The ArCADia software:  

Use one of the following methods: 

o Choose the Home ribbon and then in the Files logical group choose the Open button. 

o Press the ArCADia  button and then press the Open button 

AutoCAD or ArCADia-INTELLICAD software: 

Use one of the following methods: 

o Choose File>Open. 

o Select the Open tool on the Standard toolbar . 

o Write open and then press Enter. 

 

Common for ArCADia, AutoCAD and ArCADia-INTELLICAD software 

1. Choose the type of the file you want to open from the file type. 

2. Choose the folder that contains the selected drawing. 

3. Do one of the following: 

o o Choose the drawing that you want to open and click Open. 

o o Double-click the drawing you want to open. 

If the drawing requires a password, provide the password, then click OK to verify the password and 
then click Open again. 

2.5 SAVING A PROJECT (CAD) 

A drawing may be saved at any moment. 

In order to save a drawing use one of the following methods: 

The ArCADia software: 

Choose the Home ribbon and then in the Files logical group select the button Save. Press the 

ArCADia button and then the Save button. 

 

AutoCAD or ArCADia-INTELLICAD software 

On the Standard toolbar click Save. 

Choose File>Save. 

Write save and then press Enter. 

Write qsave and then press Enter. 

When you save a particular drawing for the first time, the system will display a dialogue box Save 

drawing as, which enables you to select the folder and provide the name for the drawing. You can 

use any name desired when saving the drawing for the first time. In order to save the same drawing 

under a different name later, select File>Save as and then type in the new name. 
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2.6 AUTOSAVE AND BACK-UP COPY (CAD) 

In order to avoid data loss in case of a power outage or another system error, it is necessary to save 

your drawing files often. The software may be configured to periodically save your drawings 

automatically. The Autosave setting determines the interval in minutes between automatic saves. 

The software resets this interval each time the user saves a drawing file (feature available in 

ArCADia-INTELLICAD and AutoCAD). 

When the Autosave feature is activated, the software creates copies of the drawing. This file is 

automatically saved to the folder provide under Options>Paths/Files>Temporary file and given the 

extension indicated in the Drawing autosave file extension (SV$ by default). 

Configuring ArCADia-INTELLICAD to automatically save drawings 

1. Do one of the following: 

o Select Tools>Options. 

o Write config and then press Enter. 

2. Click the General tab. 

3. In the Autosave area select one of the check boxes in order to enable the Autosave feature and 

select the autosave frequency. 

4. Click OK. 
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3. WORKING WITH THE SOFTWARE 

 



ArCADia-EXTERNAL GAS INSTALLATIONS User Manual 

Working with the software 

 

12 

3.1 BASIC INFORMATION ABOUT THE SOFTWARE 

The ArCADia-EXTERNAL GAS INSTALLATIONS allows for designing the outdoor gas installation 

connection in the scope of: gas pipeline routing, defining the benchmark ordinates of the gas pipeline 

routing, fitting localization and depth, gas cabinets localization and sizes and performing calculations 

to verify the correct collection of diameters based on an assessment of the pressure loss and the gas 

flow speed in the pipelines. The software allows the user to execute the drawing part on the geodetic 

backgrounds and longitudinal profiles of the pipelines. 

Inserting any gas installation item activates the software. The software was designed to ensure a 

flexible (free) course of action when creating a drawing. 

The user has the possibility for customized drawing initiation, customized organization and 

customized drawing profiles division. The user can start a project from the gas connection, and more 

specifically from the source pipeline (the points of connection into the network) to the main valve 

cabinet, and then design elements placed after the main cabinet and before the building's cabinets. 

The user can also design only the outdoor gas installation, without the connection. In that situation, 

the initial parameters will be set in the main valve cabinet. 

Simultaneously to inserting objects, the designed and existing terrain is shaped. Every object is 

assigned two benchmarks: the designed one and the existing one taken from the map. The terrain 

can also be individually shaped without the need to insert the gas installations items. 

Phase I - creating a drawing. 

1. Designing the gas supply layout in a building can be started from any element (item) by dragging 

it into an open geodetic background in a dwg file or a new dwg drawing (when the building's 

power supply layout without a geodetic background is simulated) from the toolbar. 

2. Items from a particular group can be placed on a drawing by selecting them from the toolbar and 

attaching them to the cursor. After clicking on the drawing, the item will be placed in the chosen 

spot on the geodetic background. 

3. Designing the building's external gas supply can be started from a gas connection project. To do 

that, the Connection point must be defined. That point will be the "power source" for the gas 

connection and the outdoor installation layout. The main valve cabinet can also be inserted as 

the first item followed by the connection point. The elements shall be connected with each other 

with pipelines and they have to meet the required technical parameters. Item placing sequence 

is not important. On the other hand, the logical item connection with the pipelines must be 

maintained. 

4. The part of the installation subsequent to the free-standing main cabinet (for example) is done 

by creating a pipelines layout connecting that cabinet with the cabinets assigned to buildings. 

5. The required hourly gas demand can be defined in the buildings cabinets or set through 

calculation when you know what equipment is placed in a particular building and the 

characteristic of the building's simultaneity are known. 

6. A Connection point or a free-standing gas cabinet can be the source item. 
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7. The next step is to trace the pipelines and connecting the main box and the gas consumers with 

the installation in the drawing (connecting elements by means of a system of gas installation 

pipelines). When drawing the route of pipelines in the architectural projection the user assigns 

parameters to pipeline sections: material, diameter (pipe series of type, if applicable), section 

ending height or section slope. At the same time you need to insert gas shut-off fittings and 

measurement devices. 

8. Once the installation has been drawn, you can run a validity check on the designed installation 

layout: 

o Verifying the connection to the gas cabinet; 

o Verifying the connection of all the designed items: gas consumers, shut-off fittings, 

measurement devices; 

o Verifying the continuity of the installation – connections between all the installation 

sections. 

9. Once a validity check has been completed for all the connections, the user may generate an 

extension of the installation which provides a calculation diagram. 

Note:  The user can proceed with the drawing in any order desired.  

 

 

Phase II – calculations and material lists 

1. Once the drawings are ready and validity checks of the installation have been performed, the 

user may check and correct the assumed diameters for the design sections. 

2. After selecting Gas installation calculations and report the user generates two tables. The first 

one allows to select a calculation path, including: the critical path, the longest path and the path 

subject to the highest load. 

3. The user receives information on the total pressure losses, pressure recovery and pressure drop 

due to the difference in gas density and air density, total pressure loss, pressure upstream from 

the selected gas consumer. 

4. Based on the calculations generated by the software the user may assess the correct selection of 

diameters. For each calculation path between the main gas box and the gas consumer, the 

software determines the unit pressure loss applicable for one meter of the calculation path, 

which allows the user to determine in which design section the unit pressure drop is the highest. 

5. In the calculation table it is possible to introduce a new pipeline type, i.e. change the material, 

series of type and the diameter. After clicking the Apply button located in the Gas installation 

report window, all the changes in the diameters introduced to the calculations table that are 

mentioned above will be transferred to the graphical part. 

6. After confirming the correctness of the graphical part and the calculation part of the gas 

installation, the user may choose to generate: 

o An Item list (legend) with a division into: symbols, name, marking and item quantity. 

o An RTF list of the materials and devices used in the project in order to allow for price 

estimations to be drafted for the installation. 
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4. SOFTWARE ELEMENT DESCRIPTION 
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4.1 PROJECT MANAGER 

The Project Manager allows you to manage all elements of the ArCADia-GAS INSTALLATIONS 

program: pipelines, fittings, receivers, etc. To start the Project Manager, select the icon:  

ArCADia Program: 

 System ribbon ⇒ logical group Project ⇒ Show/Hide Project Manager  

AutoCAD or ArCADia Program: 

 ArCADia-SYSTEM toolbar ⇒ Show/Hide Project Manager  

Or type 

 isa_tllv.  

 

Drawing 1. Project Manager window 

 

In the Manager window you can also turn off elements that are not useful to the user during the 

design process by pressing the light bulb (dark bulb) next to the element name. After clicking on the 
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padlock (dark padlock) the user will not be able to make changes on the given element. By clicking on 

the printer symbol, you can similarly turn off the elements for printing. 

After selecting the elements in the Level Manager window tree, a multi-clipboard is located at the 

bottom of the window. With its help, the user can copy to the clipboard elements located on a given 

floor. You can choose which of them to copy by selecting them in the list of items. They will be 

available for pasting, e.g. on the next floor. 

Clicking the right mouse button on the object name will open a window in which you can select all 

objects. From the above window, you can change general settings for a given group of objects, such 

as color or line thickness. You can also select and edit the properties of all elements of the heating 

system by right-clicking on a group of objects, e.g. Gas pipes. Next to the group name in brackets [] is 

the number of elements belonging to this group. After right-clicking on a given group, the user can 

choose the operations he can perform. Similarly to groups, the user can manage objects. From the 

Manager tree you can select e.g. all valves and change the description, pens, fonts, renumber, etc. 

 

 

 

 

Drawing 2. Selection after right clicking on a group of objects 

 

ArCADia-EXTERNAL GAS INSTALLATIONS adds its own tools to the ArCADia-INTELLICAD/AutoCAD 

menu, as described in the tables below: 

 

Drawing 3. The tool ribbon ArCADia-EXTERNAL GAS INSTALLATIONS  

ArCADia-EXTERNAL GAS INSTALLATIONS toolbar (AutoCAD or ArCADia-INTELLICAD software) 

 

Tab. 1 Functions of the ArCADia-EXTERNAL GAS INSTALLATIONS 

Icon Option Description  

 

Show/Hide Project 
Manager 

Displays or hides the level management window. 
This feature is available in the View tab in the 
Show/Hide logical group 
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 Show options 
Enables settings the basic drawing options. This 
feature is available in the Home tab in the 
Modules logical group, 

 

 
Insert connection 
point 

It allows the user to define the parameters 
for inserting the designed pipeline to the gas 
source (gas pipeline) 

Χ 

 
Insert outdoor gas 
box 

Inserts a gas cabinet along with a description 
and parameters Χ 

 
Insert outdoor gas 
valve 

Inserts a gas cabinet along with a description 

and parameters 
Χ 

 
Insert outdoor gas 
pipe* 

Inserts a gas pipe along with a description 
and parameters Χ 

 
Insert outdoor 
vertical gas pipe 

Inserts a vertical gas pipe along with a 
description and parameters Χ 

 
Convert line into 
Gas Pipe 

The inserted line of the CAD command will 
be converted into a gas pipe with given 
parameters 

Χ 

 
Insert horizontal 
casing pipe 

Inserts a casing pipe onto a non vertical gas 
pipeline and defined the parameters Χ 

 Vertical casing pipe 
Inserts a casing pipe onto a vertical gas 
pipeline and defined the parameters Χ 

 Insert survey point 
Inserts a survey point providing information 
concerning coordinates of any element Χ 

 

Change network 
elevation 

Allows to change the vertical location of all 
selected elements Χ 

 
Outdoor gas 
installation profile  

Generates outdoor gas installation profile Χ 

 

Generate a material 
list* 

Generates quantitative lists of materials used 
in the project. Χ 

 

Insert material list 
from selected 
elements* 

Inserts a user defined material lists table into the 
drawing Χ 

 
Generates an 

element list 

Generates a quantitative list of elements 

used in the project along with their markings 

(legend) 

Χ 

 
Insert selected 

elements list 

Generates a quantitative list of the elements 

selected by the user 
Χ 

 

 Outdoor gas 
installation 
calculations and 
report* 

Displays the calculation tables and generates 
a report presenting the technical calculations 
and the validity of the designed installation   

Χ 

 

Gas installation 
verification 

Generates a list of erroneously designed 
elements Χ 

 

Generate 
coordinates  

Creates a list of survey point coordinates in 
the RTF format. Χ 

 
Project options Displays a project settings dialog box. Χ 
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Help* 

Displays the help window. 
(Help is located on the left side of the 
ArCADia software menu) 

Χ 

* Icons marked with this triangle are extendable icons that have more than one command 

Tab. 1. Features of the ArCADia- EXTERNAL GAS INSTALLATIONS toolbar 

4.2 GENERAL SOFTWARE OPTIONS 

The ArCADia software: 

After clicking the icon:  System Ribbon  logical group Options  a dialogue box with the 
general options of ArCADia is displayed.  

AutoCAD or ArCADia-INTELLICAD software: 

After clicking the icon: Architecture toolbar   toolbar  

or input ISA_O  

This window includes the tabs of the available ArCADia software. 

 

  

Drawing 4. ArCADia system options window 

After selecting the ArCADia-EXTERNAL GAS INSTALLATIONS tab the software options window is 

displayed. 

Tracking options are displayed on the left. In this window the user may define custom tracking and 

detection options.  

Tracking precision control group 
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Elements – software’s element detection precision, e.g. Gas meter element connectors. 

Axes – elements’ axes detection and tracking precision. 

Angles - detection and tracking precision of the angles set in the Angles tracked control. 

Angles tracked control group 

Here the user may add, using the  Add button, another item to the list of angles tracked and using 

 button the user may remove the value of the angle tracked marked on the list. After adding an 

item, the total value of the angle should be input. The default value is 90.0°. 

 

Drawing 5. ArCADia system options window 

 

Drawing 6. Project options window, General tab 
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Drawing 7. Project options window, Default symbols tab 

In this window the user may define the settings in one of two tabs of the software: General and 

Default symbols 

GENERAL TAB 

Appearance control group 

Symbol scale – setting the size of item symbols where the dimensions are not editable for the user. 

 Update all – Marking this check box will change the scale of all previously inserted symbols to 

the one defined by the user in the editing field next to the check box. 

Gas fuels control group 

 

After clicking the  button the software will display the Gas fuel element properties window. 
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Drawing 8. Gas fuel element properties window 

Gas fuel parameters control group  

The parameters listed in this section are used in calculating pressure losses. 

Gas fuel family - the user selects the fuel family that will be used to power the installation from 
the drop-down list (in accordance with PN-C-04750: 2002): 

 Manufactured - family 1 

 Natural - family 2 

 Liquefied C3–C4 – family 3, 

 Hydrocarbon and air gas mixture - family 4 

 Biogas - family 5 

Gas fuel group - a drop-down list of gas fuel groups is assigned for every item from the list 
above. The user chooses the appropriate group. 

Manufactured gases family: 

 Low caloric - Sn group 

 Medium caloric - Ss group 

 High caloric - Sw group 

Natural gases family: 

 Nitrogened - Ln group 

 Nitrogened - Lm group 
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 Nitrogened - Ls group 

 Nitrogened - Lw group  

 High metane - E group 

Family – Liquefied Gases C3-C4: 

 Propane butane (P/B), 

 Industrial propane (P). 

Hydrocarbon and air gas mixture family: 

 Mixture of liquefied C3–C4 gasses with air (GGP), 

 Natural gas and air mixture (GPZ). 

Family – Biogas: 

 Biogas BG. 

According to their personal knowledge and the information contained in the technical requirements 
(if available), the user should type in the following parameters: 

1. Gas fuel density [kg/m3], 
2. Gas fuel kinematic viscosity [m2/s], 
3. Air density [kg/m3], 

 Normal conditions – after marking the checkbox the software will automatically assume 
air density as at normal conditions, 

4. Combustion heat or fuel value [MJ/m3] – after marking one of these and inputting its value 
the second, unmarked parameter will be greyed out and calculated approximately. 

Connection parameters control group 

Includes the maximum pressure range that are possible in a source pipeline at the connection inlet 

(external installation). 

The user chooses a pressure value as set forth in thetechnical requirements or other design 

guidelines from the permissible building supply pressure range: 

 low pressure (up to 10 kPa inclusive), 

 medium pressure (from 10 kPa to 500 kPa), 

 increased medium pressure (from 500 kPa to 1600 kPa). 

After selecting the pressure in the connection, based on the conditions (or other guidelines), the user 
inputs the minimum and maximum pressure that may occur in reality in the gas connection (by 
default the software inserts hints about the range depending on the pipeline connection). 

DEFAULT SYMBOLS TAB 

Default symbols control group 

The user has the possibility to either keep the existing basic symbols for gas installation items or 

input their own symbols. The designations provided will be automatically be inserted together with 

the item. 

FITTINGS TAB 

 Control group Appearance  

Symbol diameter – In this field, the user sets the size of the symbol inserted at the point of the 

generated set of fittings (circle diameter).  

Control group Detection 
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Connect reduction fittings – By checking this box, the diameter and direction change or diameter 

change and branching will be carried out using the DN1 / DN2 reduction elbow (tee, reducing four-

way piece), and not using two separate fittings (DN1 elbow + DN1 / DN2 reduction, tee or four-way 

piece DN1 + DN1 / DN2 reduction). 

Generate four-way piece – By checking this box, in nodes where four pipelines meet, a four-way 

piece will be generated and not pairs of tees, as in the case if it was not selected. 

Angle detection precision and Angle – In this table, the user defines which bends (angles) on the 

installation he will treat as typical (e.g. 30, 45, 60, 90 °) and from what range of values of angles (+/-) 

are they to be interpreted as a typical angle. 

Tab. 2 Table of typical angles 

 
 

If for the above given set of typical angles the user in the field Angle detection precision sets 2°, 

then: 

 angles between 28-32 ° will be treated as 30 °, 

 angles between 43-47 ° will be treated as 45 °, 

 angles from 58–62 ° will be treated as 60 °, 

 angles between 88–92 ° will be treated as 90 °.  

Other angles of bends will be presented with the values read from the geometry of the elements. 

To sum up, according to the above examples of settings for angles: 

 a 30 ° elbow will be generated for the 31.5 ° route bend, 

 a 78.4 ° elbow will be generated for the 78.4 ° route bend . 
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5.  DESCRIBING AND EDITING ITEMS 
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5.1 PRELIMINARY NOTES ON ITEM EDITING 

Editing each item involves inserting an item symbol onto the geodetic background or other drawing 

that shows the terrain development in a drawing model. There are two types of items in the software 

that are divided due to the definition of their characteristic actual geometric dimensions, i.e.: items 

that require geometric parameters to be provided and objects that are reflected only through 

graphic symbols without defining their actual dimensions. 

The item symbol includes information on the characteristic parameters, i.e. technical, process and 

geometric parameters (if required) of the item that are necessary to create supplementary drawings, 

carry out calculations and validate their correctness. 

An item is inserted into the model by selecting the relevant icon Tab. 1 from the software's toolbar 

Fig. 1(2).  The item insertion window appears, allowing the user to insert an item by defining the 

handle on the contour or at the item's characteristic point, as well as enabling spatial localization (for 

example the installation level for the selected characteristic item). 

By unticking the Import from element  check box, the user has the possibility to insert an item, 

connecting it in the appropriate characteristic point of the item with a connecting element of 

another item already inserted onto the drawing. 

Import from element - if the button is active, clicking the previously inserted element (for example a 
vertical pipe) will import the installation level from its characteristic points and automatically add the 
inserted element (for example a valve) on a similar level (for example to one end of the vertical pipe - 
example below).  

The window also includes options that facilitate accurate insertion of the item. These options are 

activated by selecting the appropriate tracking or detection feature for other items already existing 

in the drawing. 

There are two ways to insert an item into a drawing: 

Method I: 

After selecting the appropriate icon from the toolbar ArCADia–GAS INSTALLATIONS EXTERNAL 

(Fig. 1, 2) an item insertion window will appear. When it appears, the user may edit the item's 

parameters by selecting the button  corresponding to the Item properties in the item insertion 

window. 

After that, the dialog box Element properties (element name), will appear, allowing the user to 
change the item characteristic parameters. After entering the settings press the OK confirmation 
button, which will take you back to the item insertion window, where you need to click the selected 
location in the drawing field with the item symbol (attached to the cursor). After defining the object’s 
angle it needs to be clicked for the second time to insert the object. This procedure ensures that the 
parameter settings and fonts, pens and areas are saved for each subsequent item of the same group. 

 
 
 



ArCADia-EXTERNAL GAS INSTALLATIONS User Manual 

Describing and editing items 

 

26 

 

Drawing 9. Inserting object window, General view 

Tab. 3 Functions of the ArCADia-EXTERNAL GAS INSTALLATIONS toolbar 

Icon Description 

 

Change of the position of the object insert handle 

 

Go to the element properties window 

 
Fields for launching ordinate insertion. 

 Retrieving ordinate values from the previously created terrain surface. 

 Retrieving values from text. 

 

Check boxes for inserting characteristic elements of objects: absolute 
elevation or depression in relation to the designed area 

 
The field for entering the elevation of the terrain or a characteristic element 
of the object 

 The field for entering the depth of the characteristic element of the object. 

 

Gets the elevation value from previously inserted objects. For example, it 
allows the automatic connection of two gas pipelines by axes. 

 

This function enables automatic copying of values from a designated field 

 

The function of tracking characteristic elements previously inserted into the 
drawing field of objects (e.g. tracking axis of pipelines) 
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The function of detecting objects previously inserted into the drawing field 
(detects edges or characteristic elements of objects) 

 

This function enables inserting linear objects with angle detection relative to 
previously inserted linear objects in order to connect them at the assumed 
angle. The values of the angles and the accuracy of their detection is set in 
the Design Options window. 

 Insert 2D and 3D objects with rotation around the Z axis. 

 
The function allows entering the selected element at a given distance from 
the indicated point. 

 This function allows you to enter an item halfway of the indicated distance. 

 
This function allows you to enter elements in the percentage division of the 
indicated section. 

 

 

Method II: 

After selecting the appropriate icon from the ArCADia–EXTERNAL GAS INSTALLATIONS toolbar (Fig. 

1) insert the object symbol using the object localization feature. Next, select the item, which will 

display a toolbar that allows modifications. 

 

 
 
 

 

Drawing 10. Item modification selection toolbar – Action Bar 

 

Tab. 4 Functions of the modification selection toolbar 

Icon 
Description 
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Go to properties dialog box 

 
Fonts and pens painter 

 
Type painter 

 
Description painter 

 
Edit description 

 
Set description on the link 

 Renumber objects 

 

Lengthen/shorten pipe maintaining slope (applies to non-
vertical pipes) 

 

 

Move with connections 

Move without connections 

 
Remove selected elements 

 
Access to libraries - project and global 

 

You can edit the item's parameters by selecting the  button. Once the parameters are set in 

the Item properties window, you can press the OK confirmation button, which will change the 

parameters of the previously inserted item. 

The Item properties windows are used to set the characteristic, geometric and technical parameters 

of an item and are divided into control groups for every item: 
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Drawing 11.  Sample element properties window 

 

Each object property window consists of icons grouped in panels. Panels can be collapsed, which 

hides the group -   - button collapsing the panel. 

Item management control group 

Symbol – setting the name displayed on a projection along with the item's subsequent number. If the 

user does not implement any change in the active window, the name will be generated from the 

Options window. 

Element ID – the number of the subsequent inserted element of a given type. 

Type – this control allows inserting items using the global item type library (example items, e.g. items 
from the manufacturer's catalogue) and using the item type library of the items already used in the 
project, which is created in the course of design or transferred into the Project library using the 
Types editor. In this group of controls you can define your own example items and add them to the 
Project library. 

Group – possibility of creating groups of objects, e.g. for different purposes, and the possibility of 
later selecting them for editing or changes. 

Icon Description 

 
Access to libraries - project and global  



ArCADia-EXTERNAL GAS INSTALLATIONS User Manual 

Describing and editing items 

 

30 

 
Saving type in a library of a given type based on the current 
settings in the properties window 

 

 

Expands the list of object groups of the given type 

Adding a new group of objects of a given type 

 

Appearance control group 

The set of controls included in this group is the same (or very similar) for all domain items included in 

the software. 

Icon Description 

 Launching the overview drawing 

 Launching object preview on the projection 

 Starting 3D view preview 

 

Angle - by changing the value in the editing field, the user can change the angle at which an item will 

be inserted. 

Pens – setting the thickness, contour drawing lines on a model and 3D view. 

Fonts - setting the font format for the name displayed in drawing projections. 

Surfaces – setting the colours and patterns of the surfaces visible in 3D. 

Description – selecting the checkbox on the left of the Description control (ticked) activates it. 
Pressing this control invokes an appearance and description configurator. 

 

Drawing 12.  Description configurator – main window view 
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In this window the user may set the technical contents of the description components (different for 
the particular item) and their sequence of placement and localization against the description line. 
After pressing the appropriate (upper or lower) line content button, an additional window is 
activated where you can select the layout and contents (example of setting the bottom line for a 
pipeline description) 

 

 

Drawing 13.  Description configurator window view 

There are two tables in the description configurator window: 

 on the left side Available components – possible to use variants of the description 

 on the right side Used components – description variants used for the content of the 
selected line.  

Icon Description 

 

Buttons for moving a given description component from the 
Available components window to the Used components 
window 

 

Buttons for ordering descriptions in a row from left to right 

 

There are two tables in the description wizard window: the available components on the left side and 
the contents of a particular line on the right side. The availability of components for a particular line 
depends on introducing them into an inactive line. Inserting the desired line into the description is 
done by selecting the name of the description and pressing the arrow towards the line description 
content table. The selected description title will be transferred and therefore won't be visible in the 
Available components table. Should the user wish to share the component, he needs to act in a 
similar manner. He selects the description component in the line content table and then uses the left 
arrow to transfer it to the available components table.  

The elements of the description sequence in a particular line are set from left to right as per the top-
down sequence in the line contents table. You can change the sequence by marking a component in 
the line contents table and controlling the sequence change buttons, which causes the sequence of a 
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particular component to be changed by one field. Each use of the arrow moves the item one field up 
or down. The changes will be applied after pressing the Close button. 

Area altitudes control group 

Allows the user to insert a benchmark, reflecting the physical height of the terrain. Inserting at least 

three benchmarks allows to defined the area plane. A benchmark is assigned to each item. Since the 

benchmarks are independent, the user can also create a reflection of the area plane. 

Parameters control group 

This is a set of individual controls for each item. Allows the user to set the defining installation 

parameters, for example the item location, its functions, elevation etc. 

Additional equipment – a button opening a table where you can insert additional equipment, 
elements of which should be included in the material lists, is available for some items. 

 

Drawing 14.  Additional equipment window 

The  mark may be used by the user to add a relevant item from the drop-down list. At the same 

time you can insert your own entry into a table cell, changing the units and quantity. The  button 

removes the marked item. The   arrows change the sequence of the marked element 

placement. 

Type parameters control group 

This is a set of individual controls for each item. Allows the user to set the parameters that specify a 

particular item, for example technical or geometric parameters. 

Description control group 

This is a set of controls common for each item. 

Symbol – setting the name displayed on a projection along with the item's subsequent number. If the 

user does not implement any change in the active window, the name will be generated from the 

Options window. Element ID – the number of the subsequent inserted element of a given type 
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5.2 CONNECTION POINT 

To insert a Connection point object to the model, click the icon: 

ArCADia software:  

 Gas ribbon  logical group Outdoor gas installations   

AutoCAD or ArCADia-INTELLICAD software:  

 Outdoor gas installations toolbar    

or write  

 iogas_ogcp. 

An item insertion window is displayed. 

 

Drawing 15.  Connection point insertion settings window 

The point of connection symbolizes and defines the way in which the designed gas section is 

connected with the existing source pipeline. 

The window allows the user to set the appropriate insertion position for the point of connection by: 

2. having the user select an anchor on the contour or the middle point. 

3. selecting the insert relevant to the already drawn elements feature, i.e. setting the elements 

detection, elements tracking, sections detection and section ends tracking features. 

 

Area altitudes control group  

It is available in every gas installation project. These controls allow the user to insert a terrain point 

over an item's characteristic point. A benchmark reflects the actual terrain elevation. Inserting at 

least three benchmarks allows to defined the area plane. A benchmark is assigned to each item. 

Since the benchmarks are independent, the user can also create a reflection of the area plane. 

 - After pressing the Take value from text button, the user has the possibility to select the 

benchmark ordinate from the map only if the map is in digital format. The user clicks on the number 

representing the terrain ordinate and that value is typed into the window. 
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 - After pressing the button, the user has the possibility to edit only the existing terrain, while the 

designed area takes the same value. 

If a terrain that has been built in the ArCADia system is available, the user can select a checkbox and 

the terrain values will be read automatically.  

Setting the benchmark ordinate or the nesting level of an element - (unticking the checkbox) allows  

the user to set the depth of an axis to the designed or existing level. 

Axis installation level connection point settings – selecting the Check box allows for adjusting the 

height of the axis to the existing element (e.g. pipeline). Approximated height should be inserted, 

especially if there are different elements on different heights in one place. Height can be inputted 

manually in the editing field. 

 

The window also allows the user to use the project libraries or the global libraries. The user can 

select an exemplary type of connection mould used in the project from the drop-down list of a 

particular library. 

When the connection point insertion window is active, a conventional marking of the particular point 

shows up on the model's drawing field (projection). Clicking a chosen spot inside the drawing area 

inserts a designation symbolising the item. The marking on a projection of this item does not have 

the actual dimensions and ismeant solely for demonstrative purposes. To change the size of the view 

connection point, symbols scale need to be changed in the Project options window. 

The Connection point element properties editing window is displayed by selecting the  button 

or double-clicking the inserted element. 
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Drawing 16.  Connection point element properties window 

Parameters control group 

Setting the installation and technical parameters of the point of connection to the source gas 
pipeline: 

Axis ordinate - the user inserts the required source gas pipeline axis ordinate value (editing the axis 
can be optionally turned on interchangeably with the nesting level edit) 

Nesting level - the user may insert the nesting level value instead of the axis ordinate value. 

Additional equipment - a button that activates the window where the user can insert additional 
equipment elements that should be included in the material list. 
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Drawing 17.  Defining the additional equipment of a connection point 

Additional equipment elements can be selected from the list or the user can type them in 
individually, inserting user-defined name into the list. 

Gas parameters – the two buttons  allow for selection of the 

installation (gas fuel type) where specific point will be installed. If the user has several gas fuels 

available in the external gas installation project settings, then after clicking the icon he will have list 

of the available fuels visible   The button  is located next to the field. It 

allows for passage to the Gas fuel element properties. After entering the properties the user can 

inspect or change basic parameters of the installation ( gas fuel, velocity criteria, permissible 

pressure losses).  

Gas pressure downstream - the user enters the pressure value after estimating the pressure losses in 

the connection system to the source pipeline. The value must be lower or at most equal to the values 

entered in the gas parameters definition window. In other words, it is the pressure value minus the 

pressure losses at the gas connection. 

Pipe parameters control group 

Here the user defines the parameters of pipelines that are not inserted directly. There are two 

buttons in this group: One of the allows for setting the characteristic parameters for source pipeline, 

the second one allows to set the parameters of the branch (connector that connects the connection) 
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Drawing 18.  Window for defining the parameters for pipes that are not inserted directly 

 

Type parameters control group 

In this part of the window, the user has the possibility to define the connection type, in other word, 

they can choose the way that the connection to source pipeline is made. The connection mould type 

is defined by choosing its geometric layout. 

The user chooses the following elements from the drop-down list: 

Connection type: 

1. Coaxial lateral - side saddle - a connection mould that allows the user to connect the connection 

pipe to the source pipeline from the side at the same axis level. 

2. Coaxial lateral - three-way fitting - connection geometry as in item 1. The connection mould is a 

three-way mould. 

3. Coaxial pipeline extension - a connection type executed from the front of the pipeline, in other 

words, an extension of the pipeline. 

4. Non-coaxial lateral - top saddle - a connection type executed with a connection mould that is 

not connected to the pipeline at the same axis level. The connection goes to the side from the 

source pipeline and its axis is above the source pipeline axis. After selecting this type of 

connection, the Distance between axes editing field appears, where the user types in the total 

positive value, thus defining how many centimetres above the source pipeline the connection 

axis is. 
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5.3 OUTDOOR GAS BOX 

The Gas box item is inserted into a model after selecting the icon: 

The ArCADia software:  Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS    

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar    

or type IOGAS_OGB 

An item insertion window is displayed  

 

Drawing 19. Outdoor gas box insertion settings window 

The window allows the user to set the appropriate insertion position for the box by: 

The user selecting an anchor on the box contour or the middle point. 

Selecting the insert relevant to the already drawn elements feature, i.e. setting the elements 

detection, elements tracking, sections detection and section ends tracking features, 

Box bottom installation level settings - unticking the Checkbox allows the user to adjust the 

bottom height to the existing element (e.g. the pipeline). 

The window also allows the user to use the project libraries or the global libraries. The user can 

select an exemplary type of gas box from the drop-down list of a particular library and use it in the 

project. 

The user sets the ordinate of the bottom or the installation level against the designed terrain. 

When the gas box insertion window is active, a box symbol shows up on the model's drawing field 

(projection). Clicking a chosen spot inside the drawing area inserts an item. 

 The gas box properties editing window is displayed by selecting the  button or double-clicking 

the inserted element. 
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Drawing 20. Item properties window – Gas box 

In the gas box properties window you can adjust the appearance of the item in the projection, as well 

as the installation and technical parameters necessary to execute in the further part of the 

calculations. 

Parameters control group. 

Bottom ordinate  

Bottom installation level  

The designer selects an adequate parameter and types the Box bottom ordinate or Box bottom 

installation level against the designed terrain into the editing field. 

Additional equipment - a button that activates the window where the user can insert additional 

equipment elements that should be included in the material list. 
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Drawing 21. Defining the additional equipment of a gas box 

Additional equipment elements can be selected from the list or the user can type them in 

individually, inserting user-defined name into the list. 

NOTE! If the user is designing only the outdoor installation downstream from the free-standing gas box without a 
gas connection, the gas box should be treated as the gas source. The user can change or set new gas 
parameters at subsequent elements, changing these simultaneously for the upstream items. 

Calculate flow 

After activating this button and by pressing it, the user has the possibility to calculate the gas 

demand for the connection or a section of the outdoor installation, defining the quantity and type of 

gas equipment installed in the building. 

 

Drawing 22. Flow calculation window 

The flow calculation window provides the user with a table. 

 In the first column the designer defines the gas equipment by clicking on the appropriate cell and 

choosing the appropriate gas equipment from the drop-down list. 

In the second column the user inputs the power values in kW or uses the default power value. 

Unit gas consumption for a single piece of equipment of a particular kind is calculated in the third 

column and the value is provided in m3/h. 

In the fourth column the user inputs the number of pieces of equipment of a particular kind. 
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Gas consumption for all the equipment of a particular kind is calculated in the fifth column (m3/h). 

In the sixth column the user inputs the number of simultaneity groups for the equipment of a 

particular kind. 

In the seventh column the reducing simultaneity factor based on the simultaneity groups is 

calculated using the formula f = 1/n0.52. 

In the eighth column the program sets the design gas consumption for the equipment of a particular 

kind. 

The total gas consumption for all the equipment installed in the building is calculated in the Total 

item. 

Based on that the design gas flow for the section supplying gas to a particular box is calculated. 

If the user wants to input a design gas flow value other than the one calculated based on the gas 

equipment, they should untick the Calculate flow button and input the desired value in the active 

Additional flow editing field. The inserted value will be taken assumed for determining the pressure 

losses for a particular section. 

Pressure downstream the box - after selecting this field, there is a possibility to input the pressure 

value downstream the box (minimum and maximum gas pressure), taking into consideration an 

additional pressure drop at the fittings installed in the gas box. That pressure value is always lower or 

at most equal to the pressure value set upstream from the gas box. These value will be assumed for 

calculating the parameters of elements downstream from the gas box. 

Style parameters - control group 

In this group the users sets the parameters characteristic for the gas box: 

Installation method – from the drop-down list the user selects the type of box based on the possible 

locations: recess-mounted (with a flange enabling installation in a recess), free-standing (installation 

on a dedicated plinth structure), wall-mounted (installed directly on the building wall). 

Material – material used for the box (steel or plastic) 

In the width, depth, height editing fields the user sets the geometric parameters of the box. 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

  

Drawing 23. Gas box modification selection window 

5.4 OUTDOOR VALVE 

The Gas valve item is inserted into a model after selecting the icon: 
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The ArCADia software:  Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS     

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar    

or type IOGAS_OGV 

 

The valve is inserted into the projection with the handle always located in the middle of the valve 

symbol. 

  

Drawing 24. Outdoor gas valve insertion window 

The window description is the same as for the connection point window (described in section 4.2.) 

This window enables: 

 Selecting the insert relevant to the already drawn elements feature, i.e. setting the elements 

detection, elements tracking, sections detection and section ends tracking features, 

 The valve installation level on the pipeline is set by unticking the Selection field Import from 

element, which allows the user to connect the valve to the pipeline automatically. The valve 

connected to the pipeline will split the pipe into two parts. 

The window also allows the user to use the project libraries or the global libraries. The user can 

select an exemplary type of gas valve from the drop-down list of a particular library and use it in the 

project. 

The gas valve properties editing window is displayed by selecting the  button or double-

clicking the inserted element. 
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Drawing 25. Outdoor gas valve properties window 

Parameters control group. 

Setting the installation and process parameters of a valve: 

Axis ordinate - the user inserts the required valve axis ordinate value (Edit can be optionally enabled 

interchangeably with the nesting edit) 

Nesting - if instead of the ordinate value the user knows the depth, they should insert the nesting 

value instead of the axis ordinate value. 

Additional equipment - a button that activates the window where the user can insert additional 

equipment elements that should be included in the material list, e.g. spindle, street box etc. 

Type parameters control group. 

Valve diameter – from a drop-down list the designer selects the nominal valve diameter. If the 

Automatic check box next to the diameter is unticked (the parameter is set by default), then 

selection of the valve diameter is blocked and the valve only assumes the diameter of the pipeline to 

which it is inserted. 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 
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Drawing 26. Gas valve modification selection window 

5.5 OUTDOOR GAS PIPELINE 

Horizontal pipelines in the ground can be inserted into the project map by pressing the icon: 

The ArCADia software: Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS    

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar    

or type IOGAS_OGP 

 The pipe insertion window appears once it is pressed. Similar as in the previously discussed cases, by 

unticking the appropriate check box you can activate the tracking and detection features for 

previously drawn items. 

The pipeline insertion procedures are determined by properly setting the feature in the gas pipeline 

insertion window. 
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Drawing 27. The view of the horizontal pipe insertion window: for the start and the end of a 
section 

Icon Description 

 

Parallel offset ( e.g. from the wall) 

 

Set the offset direction and offset values 

Parallel offset 

In the horizontal pipe insertion windows, the Parallel offset function also appears  . Selecting this 
function allows you to draw a pipeline offset by a given distance, e.g. from another installation or 
curb line. It is possible to set an offset value in the edit field on the insert window and indicate the 
direction of the pipeline offset  i . 

 

Pipeline insertion is realised in two stages. In the first stage after clicking the insertion icon, a window 

appears for the beginning of a section. Then, after clicking a chosen point on the projection (chosen 

starting point), an ending point or pipeline slope definition window appears. 

Inserting a horizontal pipeline with a manual insertion function allows the user to insert the starting 

section height as well ending height into the editable field ("start" and "end" of a section are defined 

along with the drawing direction). This operation is realized by checking the Ending section height 

field. The user clicks a starting point of a section and draws a continuous line in the chosen direction 

and finishes by clicking the ending point of a gas pipeline section. 

If the user wants to insert a pipeline with a constant slope, then they need to select the Section slope 

check box.  Then the Section height field disappears and field allowing the user to insert the slope in 

% appears instead (Section slope). The direction of the slope is the same as the drawing direction. If 

the user wants the end of the pipeline to be located higher than the beginning, they should insert the 

slope with a "-" sign. 

Parallel offset function additionally appears in the insertion windows.  Selecting this function allows 
the user to draw the pipeline using markings, for example another installation or wall surface line 
and then move the new pipeline in a parallel fashion by a particular value.   

 

The Import from element field allows the user to add pipeline sections to the points of previously 

drawn elements.  Selections can be made independently, i.e. the user can select one or both of the 

fields. While editing the beginning of a section, the user inserts the estimated height (as accurately as 

possible) to a point in which the height will be measured. That estimation gives the user the 

possibility to specify which element will be the beginning of the drawing (which benchmark element 

will be the starting point). Ending of the drawing can be compatible with the scheme described above 

or the user can select the Import from element field at the estimated section ending height and add 

it precisely in the desired point. 
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The designed gas pipeline section properties defining window is displayed by selecting the 

button or double-clicking the inserted pipe section. 

 

Drawing 28. Outdoor gas pipe properties window 

Parameters control group. 

Setting the installation and geometric parameters of a pipeline section: editable fields with the 

section ending height: Starting and ending axis attitude 

The user can set the length of the route on the drawing in the model. The pipe length is read in from 

the drawing model when the Automatically field is selected. 

The user can additionally select two selection fields concerning the installation of two additional 

elements, in particular: the warning tape laid along the designed section and the signalisation cable. 

Type parameters control group 

This control group gives the user the possibility to specify the pipeline material and geometric 

parameters that have been used while designing it. 
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Material - The user inserts the material that will be used to build the pipeline sections from a drop-

down list. The designer inserts the materials allowed to be used in the particular section of a building 

according to the applicable standards. 

Nominal diameter - the user selects the nominal diameter of the pipeline section (according to the 
chosen series of type) 

Outside diameter - the pipe diameter is calculated according to the external dimensions and 

corresponds to a particular series of type of a specific nominal diameter 

Wall thickness - pipe wall thickness for a particular outside diameter. Pipe wall thickness can vary for 

a particular outside diameter. Inserting values into the editing fields allows the user to choose any 

series of type of pipelines. Roughness coefficient - the default setting of the coarseness coefficient is 

compatible with the materials that will be used to construct the installation. The user can set another 

value. 

 for steel pipelines - Roughness coefficient k=0.045 mm 

 for polyethylene pipelines - Roughness coefficient 0.01 mm 

Additional description – the user enters additional data that characterize the item and are moved to 

the material list. 

 

Drawing 29. Gas pipeline modification selection window 

 

An additional modifying function is the possibility of lengthening or shortening the pipe while 

maintaining a slope.  - Shorten / lengthen the pipe while maintaining a slope. 

The user has the possibility to use an additional modification function, which allows them to 
lengthen or shorten the pipe while keeping the slope. After selecting the horizontal pipe item and 
after choosing the icon shown on the figure above, the user clicks on a chosen end of a pipe and 
drags the marker in a chosen direction along the pipeline axis or along the pipeline axis trace. 

NOTE: It is recommended to use pipeline types stored in the project library while inserting pipelines. After 
selecting a desired type, the fields concerning the parameters will be filled automatically. 

 

5.6 VERTICAL GAS PIPE 

Vertical pipelines, for example gas boxes branches can be inserted by pressing the icon: 

The ArCADia software:  Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS   

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar    
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or type IOGAS_OVGP 

 

Vertical pipes insertion window will appear after pressing the button. Similar as in the previously 

discussed cases, by unticking the appropriate check box you can activate the tracking and detection 

features for previously drawn items. 

The user can set the pipeline insertion procedures by appropriately setting the function in the 
vertical gas pipe insertion window. 

 

Drawing 30. Gas pipe insertion window 

Inserting Vertical pipelines with a manual insertion function allows the user to type ordinates for 

both ends of the pipeline into the editable fields. The user can then edit the vertical section of a 

particular section ending height. 

The Import from element fields allow the user to add pipeline sections to the previously drawn 

element points.  For this method, editing is done in the same way as in the case of horizontal pipes. 

The designed gas pipeline section properties defining window is displayed by selecting the 

button or double-clicking the inserted vertical pipe section. 
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Drawing 31. Outdoor gas pipe properties window 

The window and the functions are the same as in the case of a horizontal pipe. The only difference is 
the lack of slope (vertical pipe). 

 

Drawing 32. Vertical pipeline modification selection window 
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5.7 VERTICAL AND HORIZONTAL CASING PIPE 

Horizontal casing pipe can be inserted by pressing the icon: 

The ArCADia software:  Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS   

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar    

or type IOGAS_OCP 

A vertical casing pipe beginning insertion window will appear after pressing the button. Ticking the 

appropriate check box activates the tracking and detection features for previously drawn objects. 

casing pipe insertion is executed in two stages. In the first stage, after clicking the insertion icon, a 

window appears for the beginning of a section, whereas after clicking a chosen point on the 

projection (selecting the beginning), a similar window appears for the ending point. 

If the user wants to insert a pipe with a constant slope, they should select the Slope field.  Than the 

Axis depth field disappears and another window appears, where the user can input the slope in % 

(Slope).  

 

Drawing 33. Horizontal casing pipe section beginning insertion windows 

 

Drawing 34. Horizontal casing pipe section ending insertion windows 

The window for defining the properties of a designed horizontal casing pipe section is displayed by 

selecting the button or double-clicking the inserted pipe. 
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Drawing 35. casing pipe properties window 

Parameters control group. 

Setting the installation and geometric parameters of a particular pipe section: editing fields with the 
section ending height: Starting and ending axis attitude 

The user can set the length of the route on the drawing in the model. The pipe length is read in from 
the drawing model when the Automatically field is selected. 

Type parameters control group 

This control group gives the user the possibility to specify the pipeline material and geometric 
parameters that have been used while designing it. 

Type - the user inserts the pipe type used in the project from a drop-down list.  

Outside diameter - the pipe diameter is calculated according to the external dimensions and 
corresponds to a particular series of type 

Wall thickness - casing pipe wall thickness for the selected outside diameter.  
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Function - the user inserts the function that will be assigned to the casing pipe from a drop-down list. 

The user can choose from four functions: ramming, directional drilling, open excavations, external or 

divided casing pipe. 

The window also allows the user to use the project libraries or the global libraries. The user can 

select an exemplary type of casing pipes used in the project from the drop-down list of a particular 

library. 

 

 

A vertical casing pipe can be inserted by pressing the icon: 

The ArCADia software:  Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS   

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar    

or type IOGAS_OVCP 

A vertical casing pipe beginning insertion window will appear after pressing the button. Ticking the 

appropriate check box activates tracking and detection functions for previously drawn objects . 

 

Drawing 36. Vertical casing pipe insertion window 

Inserting a Vertical casing pipe with a manual insertion function allows the user to input attitudes for 

both ends of the pipe into the editing fields. The user can then edit the vertical section of a particular 

section ending height. 

The window for defining the properties of a designed vertical casing pipe section, same as for the 

horizontal casing pipe, is displayed by selecting the button or double-clicking the inserted 
pipe. 

 

5.8 EDITING AND INTRODUCING TYPES 

To display the Type library editor dialog box, click the icon: 

ArCADia software: 

 The Home ribbon  logical group Modules    
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AutoCAD or ArCADia-INTELLICAD software: 

 ArCADia-SYSTEM toolbar    

or write 

 ISA_ETL. 

The Type library editor is used to edit and introduce new item types into the ArCADia software. It 

facilitates access to manufacturers catalogues and enables selecting only those catalogues which the 

user uses most often when designing. Additionally, types are divided into a Standard library (i.e. the 

library provided with a given software version) and a User library, where all the new or user modified 

element types are saved. 

 

Drawing 37. Type library editor window 

In the upper part of the type editor window the user has the possibility to select a branch  

from the drop-down list where all the branch-modules available in ArCADia are listed. 
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Drawing 38. Drop-down list view available in the ArCADia system. 

After selecting the appropriate branch the user has access to all the items from the Elements drop-
down list (on the right) available in the selected branch (module), e.g. drainage pipe . 

 

Drawing 39. Drop-down list of the elements available in the Sewage installations branch in the 
ArCADia system.  

After clicking on the selected element in the Global library all element types will be available. During 

the first run it will be Standard library types (files provided with a given version of the software). 

During the design process you may add additional types into the libraries, creating a User library. 
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Drawing 40. Type library editor window after selecting an appropriate branch and 
one of its elements. 

 

The lower part of the editor window is divided into the Global library (left) page and Project library 

(right) page. 

The Global library is the place where all the default element types available for the user and the 

elements added when working with the software are added; it is divided into the Standard library (a 

library provided with a given version of the software, which the user does not change) and a User 

library, which contains elements (types) saved by the user when working with the software. 

Project library – where all the element types used or available for use in the project are listed. The 

type for the element can be can be selected from the element properties window: 

 

Drawing 41. Type insertion from the level of item properties 
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and in the modification and insertion windows: 

 

Drawing 42. Type insertion point from the element modification and insertion window level 

Above the type library windows there are icons with the following functions: 

Add new type  – after clicking this icon the user has the possibility to add a new type to the Global 

library or the Project library (to the User library). It is also possible to edit type properties for the 

particular element, where the user may determine all the element’s characteristic parameters, 

including type parameters, view. 

NOTE! Clicking the Add new type icon when a type has been previously highlighted in the Library will add a new 
type based on the highlighted one. This facilitates entering a catalogue of items to the library, e.g. supplied by one 
company, where the only distinctive feature is e.g. the diameter. 

Add new folder  – after clicking this icon the user has the possibility to add a new folder, where he 

can then later add element types. A window prompting for the folder name will appear. After 

entering the folder name you need to press the  button in order to add the folder to the 

library or  to cancel the command. 

 

Drawing 43. Folder types insertion window 

Delete  – after clicking this icon the user may delete the selected type or folder. 

Type properties  – after clicking this icon the user will have access to the properties of the 

selected type. These values can be edited and saved here.  

Leave only the types used in the project  – after clicking this icon in the Project library, only the 

types used in the project (used in any object in the project) will remain visible. 

After clicking a type with the right mouse button, a menu becomes available: 
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Type properties – works the same as the icon described above. 

Copy – copies the type. 

Paste – pastes a previously copied type and inserts it with the same name and subsequent number. 

Rename – the user may rename an already inserted type. 

Delete – works the same as the icon described above. 

 

The  button is located above the project library. Once you click this button, 

the Project library settings will be saved in the template and will be accessible for future projects 

using this template. Next to it there is an  icon – when clicked, it provides the user with a list of 

available templates. 

 

Drawing 44. Sample properties window 

In the Project library window you can also check what types of a particular element are currently in 

use in the projection, which is displayed in the form of a  symbol on the left of the name of a 

particular type. 
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Drawing 45. The type library editor window after entering the type to the project library. 

The following icons are available below the two libraries: 

Hide everything . After clicking the same icon the types tree in a given library will be hidden down 
to the main catalogues. 

Extend everything  After clicking this icon, the type tree in a given library will be extended. 
 
The user may also search the library by typing a part or the entire name of the desired type in the 

 field. The button  is located next to the field. After 
clicking the button, the editing search field will be cleared.  
 
Once you select types or folders, the transfer buttons located between the libraries are activated. 

Copy all to the project library  - copies the entire global library content to the project library. 

Copy to the project library  – copies the selected elements to the project library. 

Copy to the global library  – copies the selected elements to the global library. 

Copy all to the global library  – copies the entire project library content of the selected element 
to the global library. 
Messages that may be displayed when working with the Type library editor: 
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1. This message informs the user that a type with this name already exists. After clicking the 

, information from the new type will be saved and will overwrite the 
information in the previous type.  

 
 

2. This message informs the user that the types marked by the user are going to be deleted. 

The  button confirms type deletion. 

 
3. This message informs that the layout of the project library was saved to a project template, 

e.g. Standard. 

 
 

NOTE! If the user has made any changes in the Project library while working with the project, modified existing 
types or expanded the library by adding new types, the new types will become available for future projects. The 
user should add the new types to the Global library using the transfer buttons. 
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6. CALCULATIONS AND RESULT 

INTERPRETATION 
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6.1 VERIFYING THE VALIDITY OF A DRAWN INSTALLATION 

After an outdoor installation is drawn and after connecting all the pipelines and elements, the user 

has the possibility to verify the execution of the project to assess the validity of connections of the 

pipelines and other elements implemented into the project. The verification feature for the 

installation is activated by clicking the following icon in the software toolbar: 

The ArCADia software: Gas ribbon  logical group  EXTERNAL GAS INSTALLATIONS   

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar    

or type IOGAS_VER 

Next, the "Please select the starting item" command will appear in the toolbar at the bottom of your 

screen. The user can for example select the line outflow point. 

 

Then a window appears, where a table with the potential pipeline connection errors or missing 

parameters required to carry out calculations is displayed. 

 

Drawing 46. Gas installation errors report 

The table contains information concerning the number of discontinuities in the installation. The 

program detects elements of the installation that are not connected or pipeline sections that are not 

connected to the gas box and a consumer. After clicking the error information, the user will activate 

the drawing error detection feature. The software will highlight the routes and elements where 

errors occur. The designer can correct the drawing by connecting elements in order to ensure 

continuity of the installation. 

After the corrections are implemented, the software will prepare a report informing the user about 

the validity of the designed installation. 
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Drawing 47. Designed installation validity gas installation report 

The user is also provide with information concerning the gas demand for each item. 

 

Message types (message icons differ): 

 Information  

 Warning  

 Error  
 

Message content - Interpretation 

1. The installation design is correct 
The message appears when there is a main gas box present in the installation and all the 
items which are directly or indirectly connected to that point are creating an installation that 
is correctly designed in terms of connections. 

2. Unconnected pipeline 
The message appears when there is an unconnected pipeline in the project.  

3. Unconnected items: e.g. Gas valve ZG2 
The message appears when an item is not connected to any pipeline. 

4. Elements not connected to any path: e.g. SZG3 box 
The message appears when an item (also a pipeline) is not directly or indirectly connected to 
the main gas box. (It can be connected to the pipelines, although these pipelines are not 
connected to the box). 

 

6.2 CALCULATIONS 

After verifying the validity of the installation model created and preliminarily selecting the diameters 

you can carry out calculations by pressing the following icon in the software toolbar: 

The ArCADia software:  Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS   
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AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar   

 or type IOGAS_CALC 

After the icon is pressed, the "Please select the starting element" command will appear at the 

bottom toolbar. After selecting the starting element, for example Connection point, the software will 

establish the calculation sections terminated with boxes and a calculation table window will appear. 

The window contains two tables. 

In the top table the user indicates the calculation route where the pressure loss and the pressure 

value upstream from the last gas box will be calculated. 

By ticking the check box at the particular consumer the user selects the path where they will carry 

out the calculations. 

The user will be informed about the total design section length. Once the check box is ticked, the 

calculation table is filled. Calculations will be carried out starting from the selected consumer and 

ending at the main box. 

The software calculates the line losses and local losses in the design sections and provides the total 

pressure loss in the path to the gas consumer. 

The following values are listed under the table: 

Sum of pressure losses (Pa) – the total of all the pressure losses in the calculation path 

Percentage local pressure loss - the user inserts the estimated additional local pressure losses 

value (typically 1-20%). 

Local pressure loss – the value calculated according to the percentage local pressure loss 

assumed by the user 

Total pressure losses – the value including the line and local losses 

Maximum and minimum pressure upstream of the last gas box. 
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Drawing 48. Calculation tables view 

The table's columns include: 

Column 1 - Calculation section name 

Design section marking. Beginning and ending design sections node numbers. 

Column 2 - Minimum and maximum gas pressure in the intermediate design section points. 

Column 3 - Design gas flow 

Calculation flow value calculation  

Column 4 - Dimensions  

Design section parameters are imported into this column, i.e.: Design pipeline diameter 

Column 5 - Gas flow velocity calculated value  

Column 6 - Design section length of the flow path to the last gas box. 

Column 7 - Unit pressure loss  

Calculating the unit pressure drop (per 1 m of the pipeline) 

The unit pressure loss is calculated using the formula: 
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 ∆ℎ𝑗 = 𝐻𝑚𝑖𝑛.𝑖 ∙ (1 − √1 − 1,25 ∙ 108 ∙ 𝜆 ∙ 𝜚𝑔 ∙
𝑄𝑜𝑏𝑙

2

𝑑5∙𝐻𝑚𝑖𝑛.𝑖
) 

Δhj - unit pressure loss (Pa/m) 

H min– minimum pressure at installation input (Pa) 

λ – pipeline wall friction factor 

d – pipeline inside diameter (mm) 

Qdes – design flow (m3/h) 

 

Calculating the friction factor 

𝜆 =

[
 
 
 
 
 

−2𝑙𝑔
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2,51
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√

0,3164

(
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Real design velocity 

𝑤𝑟𝑧𝑜𝑏𝑙 =
𝑄𝑜𝑏𝑙

3600∙𝐴
    (m/s) 

Where A is the internal pipe cross-section area, calculated using the formula: 

𝐴 =  𝜋
(𝑑 ∙ 0,001)2

4
 (𝑚2) 

𝜈 − 𝑙𝑒𝑝𝑘𝑜ść 𝑘𝑖𝑛𝑒𝑚𝑎𝑡𝑦𝑐𝑧𝑛𝑎 𝑔𝑎𝑧𝑢 kinematic gas viscosity 

For group E natural gas the kinematic viscosity shall be assumed as 14.3x10-6 m2/s  

The k (Roughness coefficient) for steel pipes is 0.045 (mm) and 0.0015 (mm) for copper pipes 

After selecting the diameters the pressure loss value in a particular section per 1 m of the pipeline 

should not exceed the Δhmax. value. = Δhd / 1.3 Lc (Pa/m) 

The Δhj value determined in column 7 of the calculation table for a particular design section should 

meet the condition Δhj≤ Δhmax. 

Column 8. 

Section pressure losses are calculated in this column: 

Δh = L x Δhj (Pa) 

If the designer receives an inadequate value or better diameter optimization is possible in a 

particular calculation route, it is possible to change the diameters of the pipeline set constituting a 

particular design section. 

The designer double-clicks the field containing the diameter that they want to change. 
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A window allowing the designer to change the desired diameter will appear in the window Pipe 

properties. 

 

Diameter selection is carried out in the same manner as in the case of a gas pipe. 

After changing the diameter of the selected design sections and obtaining satisfactory pressure loss 

values, you should click the Apply button.  After pressing that button the changes in diameters will 

be saved and transferred to the drawing as well as to the tables for other calculation routes. 

 

Drawing 49. Editing diameters in the calculation table 
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7. LONGITUDINAL PROFILE OF THE 

OUTDOOR INSTALLATION SECTIONS 
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ww  

 

7.1 PROFILE GENERATION AND PROFILE VIEW SETTING 

A profile of the correctly drawn outdoor installation section can be created by clicking the icon: 

The ArCADia software:  Gas ribbon  logical group EXTERNAL GAS INSTALLATIONS    

AutoCAD or ArCADia-INTELLICAD software: EXTERNAL GAS INSTALLATIONS toolbar     

or type IOGAS_CALC 

After clicking the bottom bar the following message appears: "Please select the starting element:" 

After the starting element has been selected, a selection window for the calculation path is 

displayed. 

In this window the user selects the main profile path. 

 

Drawing 50. Main profile path selection window 

After clicking OK a profile path manager window appears; here the user can add additional profile 

paths that are to be visible on the drawing. After clicking OK the message "Point placement:" appears 

on the bottom bar. 
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Drawing 51. Profile path manager window 

The user must now click the location on the model where the profile is to be inserted. 

In order to modify an already inserted profile, activate the profile view and then click the profile 

frame. A profile modification window will appear. 

 

Drawing 52. Profile modification window   

Use the following buttons: 

-  to recall the profile path manager); 

-  to refresh the profile after modifications. 

The gas installation profile properties editing window is displayed by selecting the button or 

double-clicking the frame of the active profile. 
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Drawing 53. Profile modification window   

 

Appearance control group 

X scale and Y scale – The user can use a drop-down list to select the scale in which the installation 

profile is to be drawn. 

Parameters control group. 

Comparative level – The user can enter the profile comparative level. When the option Automatically 

is selected, the comparative level is set at a level lower by 5 m than the lowest point of the drainage 

system. 

Collision configurator - when this button is clicked, the collision/crossover setting window appears. 

The window is divided into two parts. Clicking on the left side allows to select the type or group of 

construction objects such as external gas pipes; checking a box on the right side allows to choose the 

objects with which the program is to create collisions or crossovers. The user can create their own 

collision setting template or choose an existing template from the global library. The software can 

also insert collisions/crossovers in three ways: crossovers only, collisions only, or both crossovers and 

collisions. After clicking OK the program will set the collision points on the profile. 
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Drawing 54. Setting collisions/crossovers window 

 

Type parameters control group. 

Profile name – The user can define the profile name shown on the model 

Table content control group 

The user can modify the profile table by adding available components such as: distance, material, 

diameter,  length, pipeline axis depth, pipeline axis ordinate, existing terrain ordinate and designed 

terrain ordinate. In order to add or remove table items use left or right arrows. To move an item 

from available to used, click the corresponding text. The function arrow will be highlighted. When the 

table is filled with all items used, you can use the up and down arrows to modify the order of items in 

the table. 

WORKING ON A PROFILE 

In the view it is possible to shape the foundation height of pipelines, gas cabinets and other objects. 

Changes made to the profile are also automatically made on the view. 

It is possible to: 

 change the descriptions on vertical references, 

 change the of ordinates of objects directly on vertical references with simultaneous change 

of pipeline gradient, 
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 change in pipeline slope with a change in the foundation of pipeline connections 

 changing the description of the pipeline material and breaking apart the outgoing text. 

Changes made to links 

To make a change on a link, click on the link and select the button to move to the link properties 

window. 

 

Drawing 55. View of the profile link properties window after selecting the link on the profile 
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Parameters control group  

Existing area / Designed area – the user can change the ordinates of the terrain with a change in the 

spot height above the object. 

Left Label /right – after checking the box - Automatic - the user can enter his own text, which will be 

entered on the selected side of the vertical reference (e.g. instead of Incorporation into the pipeline, 

you can enter a saddle tee). 

NOTE! After selecting several links, you can make changes to the descriptions on all selected objects. 

Bottom ordinate / Axis immersion – the user has the option of changing the ordinate (or immersion) 

of the pipe connections on the left side of the well and on the right side of the well. If the user sets a 

lower ordinate of the pipeline than the ordinate of the designed well, then the connection of the 

pipelines will be lowered.  

Changes in slopes and descriptions in the horizontal lines of the profile table 

To enter a slope change or pipeline description, the user clicks (or double-clicks) on the selected 

description (on the pipe description text or on the slope value). An action window is displayed and a 

window appears after switching to the dialog properties Element properties: Reference – Gas pipe. 

 

Drawing 56. Window enabling changing the pipe properties, material description and slope 
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Parameters 

In this part of the window there is a table with information about the pipeline. After selecting the 

button, the user opens the pipeline properties window. 

After unchecking the field Automatically the pipeline description text field is activated and you can 

insert your own text. 

Operations 

In this part of the dialog box, the user can change the slope of the pipeline by selecting the 

appropriate fixed point, i.e. the end of the pipeline of which the ordinate will not be changed. Then 

the user enters the slope value in% and selects the slope direction. 

It is possible to select several calculation sections and enter a common slope value, which will make  

the slope uniform on all selected sections. 

 

Drawing 57. Settings in the slope window to make the slope uniform 
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8. REPORTS AND LISTS 
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8.1 CALCULATION REPORT 

If the installation has been designed correctly, it is possible to generate a calculation report for the 

route with the least favourable location of the gas consumer (i.e. the route with the highest pressure 

loss). The RTF Report button is located at the bottom of the calculation table. When pressed, the 

ArCADiA-TEXT text editor program that supports RTF files opens 

8.2 MATERIAL LIST AND OUTDOOR GAS INSTALLATION ITEM LIST. 

The software can generate material lists and outdoor gas installation item lists. 

 

To obtain an outdoor gas installation material list, click on the icon: 

ArCADia software:  

 Gas ribbon  logical group Outdoor gas installations    

AutoCAD or ArCADia-INTELLICAD software: 

 Outdoor gas installations toolbar    

or write  

 iogas_sli. 

To obtain an outdoor gas installation elements list, click on the icon: 

ArCADia software:  

 Gas ribbon  logical group Outdoor gas installations    

AutoCAD or ArCADia-INTELLICAD software:  

 Outdoor gas installations toolbar    

or write  

 iogas _il. 

It is then possible to insert into the drawing a table with a list of all the materials and elements in the 
project. 

If the user wants to insert an element list or list containing some elements only, e.g. for a single 
room, then: 

in order to input a Selected elements material list for the sanitary installation, click the icon: 

ArCADia software: Gas ribbon  logical group Outdoor gas installations    

AutoCAD or ArCADia-INTELLICAD software: Outdoor gas installations toolbar   (or type 

iogas_slsi), select items on the projection and confirm by pressing Enter 
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or 

in order to input the Selected elements list for the sanitary installation, click the icon: 

ArCADia software: Gas ribbon  logical group Outdoor gas installations    

AutoCAD or ArCADia-INTELLICAD software: Outdoor gas installations toolbar     

(or type iogas_sil) 

 

Clicking table lines or going to Properties allows the user to modify the table content. 

After clicking the  button you can also generate RTF reports. The software also allows for 

exporting the data from a material list to Ceninwest. To do that press the  button. 

8.3 LIST OF SURVEY POINT COORDINATES 

The software can generate a list of survey point coordinates. To obtain these, click the icon: 

ArCADia software:  

 Gas ribbon  logical group Outdoor gas installations    

AutoCAD or ArCADia-INTELLICAD software:  

 Outdoor gas installations toolbar    

or write  

 iogas_rtfxy. 

The Save report in RTF window is displayed. The file can be saved in any location. 

The list contains the coordinates for all characteristic points of the outdoor gas installation and the 

coordinates for all survey points input by the designer. 

To insert a Survey point onto the design projection, click the icon: 

ArCADia software:  

 Gas ribbon  logical group Outdoor gas installations    

AutoCAD or ArCADia-INTELLICAD software:  

 Outdoor gas installations toolbar    

or write  

 iogas_geo. 

The insert survey point window is displayed. Ticking the appropriate check box activates the tracking 

and detection features for previously drawn objects. 
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Drawing 58.  Insert survey point window 

A point is inserted in the projection by clicking the chosen location.  

The Survey point properties editing window is displayed by selecting the  button or double-
clicking the inserted element. 

 

Drawing 59.  Defining the survey point element properties window 

In this window you can change the appearance of a survey point, its description and symbol, and 

read the coordinates for a particular point. 

 

 


